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‘ Web Applications
o



WEB PROGRAMS

o The programs in this chapter require the use of
either Visual Web Developer 2010 (packaged with
this textbook) or the complete version of Visual
Studio 2010.

o We assume that you are using one of these two
software products.




CREATING A WEB PROGRAM

o Click on New Web Site in the File menu.

o Select Visual Basic 1in the left pane.

o Select ASP.NET Web Site in the middle pane.
o Select File System as the Web location.

o Give a name and path for the program.
o Click on the OK button.




CREATING A WEB PROGRAM (CONTINUED)
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WEB PAGE (VWD EQUIVALENT OF THE
FORM DESIGNER)
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WEB PAGE TAB

o The Web page tab 1s titled Default.aspx instead of
Form1. vb [Design]

o The Web page is referred to as Default.aspx in the
Solution Explorer window

Default.aspx




TOOLBOX

Toolbox * 0 X
4 Standard »

Pointer
AdRotator
BulletedList
Button

AE i

Calendar

CheckBox
- CheckBoxList

The common controls, such as button, text
box, and list box are contained in the
Standard group of the Toolbox.




DESIGNING THE WEB PAGE

o Begin by clearing the Main Content region

o Permanent text (called static text) can be typed
into the page and formatted directly without the
use of labels

o Text boxes and buttons can be placed at the
cursor position (called the insertion point) by
double-clicking on them i1n the Toolbox




SAMPLE WEB PAGE

|MainContent (Custom)|
Tip Calculator

Cost of meal: I

Percent tip (such as 15, 18.5, or 20): I

Calculate Tip




PROPERTIES WINDOW

Properties v 01X
btnDisplay Systermn.Web. UL Wel -
M1 El =

(Expressions -
(10 btnDisplay

— AccessKey
BackCelor

The name of a control is specified by the
ID property instead of the Name property



CODE EDITOR

o The Code Editor tab reads Default.aspx.vb instead
of Form1.vb

o The code 1n the editor 1s referred to as the code

behind.
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SUMMARY THUS FAR

Web page counterparts to designing a Visual Basic Windows form.

Visual Basic Windows Form

VWD Web Page

. There is no cursor on the form designer.

Text to appear permanently on a form is usually
placed in a label and formatted with settings
from the Properties window.

The most frequently used controls (such as But-
ton, ListBox, and TextBox) are found in the
Common Controls group of the Toolbox.

When you double-click on a control in the Tool-
box, the control appears either in the upper-left
corner of the form or just below the most
recently created control.

. The name of a control is specified by setting its

Name property.
In design mode, controls are placed anywhere on
a form and aligned with the Format menu.

. The tab for the Designer reads “frmName.vb

[Design]”.

The page designer has a cursor (also referred
to as the insertion point).

Permanent text (called static text) can be
typed directly into the page at the insertion
point and formatted from the Toolbar in the
same way as text typed into a word processor.
The most frequently used controls (such as
Button, ListBox, and TextBox) are found in
the Standard group of the Toolbox.

When you double-click on a control in the
Toolbox, the control appears at the insertion
point.

The name of a control is specified by setting
its ID property.

In design mode, text and controls are placed
in a top-to-bottom fashion, each entered at
the insertion point.

The tab for the Designer reads
“Default.aspx”.
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SAMPLE CODE

Protected Sub btnCalculate Click(...) Handles
btnCalculate.Click

Dim cost As Double = CDbl (txtCost.Text)

Dim percent As Double =
CDbl (txtPercent.Text) / 100

txtTip.Text = FormatCurrency (percent * cost)
End Sub

Notice that “Sub” 1s proceeded by “Protected” instead of “Private”.

MainContent (Custom)
— ¥
ip Calculator

whd ol

............................................................................................................................................................................ 13




RUNNING A PROGRAM

o Press Ctrl+F5 to run program without debugging

o Program runs in the computer’s Web browser

o To terminate the program, close the browser by

clicking on

-i?:-l , the Close button

o Close program by clicking on Close Project in the

File menu.

14




A RUN OF THE SAMPLE PROGRAM

My ASP.NET APPLICATION

Home About

Tip Calculator

Cost of meal; 45

Percent tip (such as 15, 18.5, or 20): 20

Calculate Tip |

15

Amount of tip:  $8.00




TABLES

o A table control can be used to improve the
layout of a Web page

o Tables are created with the Insert Table command
from the Table menu 1n the Toolbar
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SAMPLE TABLE
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cell

This table has 5 rows and 2 columns. Each
subdivision is called a cell. 17



CELLS

o Text and controls can be placed into cells

o The alignment (such as right, left, or center) of the
contents of a cell can be specified with the Align
property from the Properties window

o Commands from the Table menu allow you to
isert and delete rows and columns, and to merge
cells
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MANAGING TABLES

o Assorted arrows can be used to highlight groups of
cells and resize tables

® 4 =+ I

o Dragging of the cursor also can be used to
highlight groups of cells
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TEXT FILES

o Normally placed in the Solution Explorer’s
App_Data folder

o A text file can be read into an array with a
statement of the form

Dim strArrayName () As String =
I0.File.ReadAllLines (MapPath ("App Data\" &
filename))

20




How TO OPEN AN EXISTING WEB PROGRAM

File Edit View Tools Window Help
21 Mew Project... Ctrl+5Shift+N
@ New Web Site... Shift+Alt+MN
1 MNew File... Ctrl+ M

_ _ fl Open Project... Ctrl+5hift+0

first click | |

here mmm— 2 Open Web Site... Shift+Alt+0
= Open File... Ctrl+0

Then navigate to the program’s folder
and click on the Open button.
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How TO ADD AN ADDITIONAL WEB PAGE TO
A PROGRAM

o Click on an existing Web page to
make sure 1t has the focus

o Click on Add New Item in the
Website menu. (An Add New Item
dialog box will appear.)

o Select Web Form in the center

pane, type a name into the Name
box, and click on the Add button.
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A PROGRAM (CONT.)

HoOw TO ADD AN ADDITIONAL WEB PAGE TO

i B
Add New Item - CA\Users\David\Documents'\MyWebProgram?, M
Installed Templates Surtbg,l:[DEfault » | EiE Search Installed Templates ~
e Type: Visual B
Visual C# EIEE Web Form Visual Basic ypes Tt Basic o
A form for Web Applications
Online Template
™ Mastrpage Vol Basic
select
EE Web User Control Visual Basic
ﬁ!g ADO.NET Entity Data Model  Visual Basic
ADO.NET EntityObject Gener...Visual Basic
click on

change
name

Marne: Default?.aspx

ﬁ!g
E}

ADO.NET Self-Tracking Entit... Visual Basic

AlAx-enabled WCF Service

Visual Basic

Add button

-

Place code in separg | file
| Select master page

Add

=1,




HYPERLINK CONTROL

o Found in the General group of the Toolbox
o Appears on a page as underlined text
o Used to navigate to another page

o NavigateUrl property specifies the page to
navigate to
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SAMPLE WEB PAGE

Tip Calculator

Cost of meal:

Percent tip (such as 15, 18.5, 20):

Calculate Tip ‘

Tipping Help < hyperlink control
Amount of tip:l

25




VALIDATION CONTROLS

o Used to validate user input

o The RequiredFieldValidator control checks
that data has been entered into a text box or that
an 1item of a list box has been selected

O View

o The RangeValidator control W Wi
checks that the entry in a text o
box falls within a specified N

#,  CompareValidator

range of values.

=r CustomValidator




SAMPLE WEB PAGE

RequiredFieldValidator

Tip Calculator l

Cost of meal: You must enter the cost!

Percent tip (such as 15, 18.5, 20): Not a valid percentage!

Calculate Tip ‘
Amount of tip: |

RangeValidator

Validation controls are not visible at run time. =

Only appear when input is missing or invalid.



REQUIREDFIELDVALIDATOR CONTROL

Properties * X
=} CostRequiredFieldValidator System.Web. ~
B =

o The key properties are ControlToVerify
and EI‘I’OI‘Message i e

AccessKey

soriaiole Mot
o The ErrorMessage setting 1s the text et
that appears when input into the 00

Enabled True

specified control does not meet the given

EnableViewState True

o o Errorfessage You must enter the ccl§
criteria +fon
ForeColor Red
Height
InitialValue

SetFocusOnError False
SkinID

Tablndex 0

Text

TeolTip
ValidationGroup
ViewStateMode  Inherit
Visible True
Width

" N ControlToValidate
ID of the control to validate,




RANGEVALIDATOR CONTROL

Properties ~ox |8
'8 RangeValidatorl System.Web ULWebCor - i

o The key properties are ControlToVerify, |75 "~

° ° (Expressions)

ErrorMessage, Type, MinimumValue, D e
° BackColor

and MaximumValue

BorderStyle NotSet

BerderWidth

ClientIDMade Inherit

ContralToValidat txtPercen t

CssClass

CulturelnvariantV False

o Possible settings for Type are String,

EnableClientScrip True

Integer, Double, Date, and Currency s T

EnableViewState True

ErrorfMessage Not a valid percentag{§l F:
> Font

ForeColor Red

Height

o The entry in the text box must lie between Mo 100

the MinimumValue and the

MaximumValue m -

ValidationGroup
ViewStateMede  Inherit
Visible True
Width

” N ControlToValidate
1D of the control to validate,




POSTBACK

o A postback occurs when the contents of a Web
page are sent to the server for processing.
Afterwards, the server sends a new page back to
the browser

o When a validation control is triggered, the matter
1s handled entirely by the browser—no postback
occurs

30




PROGRAMMING MODEL

|
! Compiler
I
| Parser
l 50
Internet Explorer : v .
e — : > % )
| hello.aspx
| @
| S Assembly Cache
| S
< ' =
j ! £
------ | (o) Memory
I
| | Assembly IL | | g—on J
| Execute :
I HTTP Runfirne
|
| ©
|
| ©
I
I
. |
Client | Server




THE PAGE LOAD EVENT

o Raised when a Web page 1s first loaded and every
time 1t 1s reloaded after a postback

o The IsPostBack property can be used to guarantee

that the page load event 1s raised only once
if Not Page.IsPostBack Then

End if
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CLASS-LEVEL VARIABLES

o In VWD, class-level variables are of limited value
since they do not retain their values after
postbacks

o Devices known as cookies or session variables can
be used to retain values

33




RADIOBUTTONLIST CONTROL

Determine Fee ‘

Age
(¢ child (<6)
(" minor (6-17) T
rblAges < |
("~ adult (18-64) rfvAge
\.{" senior (65+) You must select an age!

VWD does not have a group box control. The
radio-button list control is the counterpart of the
VB group box containing a set of radio buttons.



RADIOBUTTONLIST CONTROL (CONTINUED)

o The radio-button list control is populated via a

ListItem Collection Editor that 1s 1
the Tasks button

nvoked from

o In the previous slide, the control rfvAge, a
RequiredFieldValidator, guarantees that a radio
button has been selected before the button 1s

clicked on.

‘[asp:radiobuttonlist#RadioButtonListl]

 Selection 1 L%

RadioButtonlist Tasks

" Selection 20

i~ Selection 3
' =

Choose Data Source...

Edit [tems...

| Enable AutoPostBack I'
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CHECK Box CONTROL

&

g Benefits Menu l':' S | ——

Prescription Drug Plan ($359.15)
Dental Plan ($10.81)

Vision Plan ($2.25)

Medical Plan ($55.52)

Total monthly cost:

A

=Y CheckBox1 System Web. ULWebControls, -
“EN D =

(Expressions)

m CheckBox1
AccessKey

AutoPostBack  False
BackColor

BorderColor

Example 5 of

' Section 4.4.

In regular VB clicking on a check-box can cause code to run

VWD does not do this

To convert this VB program to a VWD program, the
AutoPostBack property of each check box must be set to 36

True
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COMMUNICATING WITH THE COMPUTER

o Machine language — low level, hard for humans to
understand

o Visual Basic — high level, understood by humans,
consists of instructions such as Click, If, Do

o Usable in other applications (Word, Excel...)

39




COMPUTERS AND COMPLICATED TASKS

o Tasks are broken down into instructions that can
be expressed by a computer language

o A program 1s a sequence of instructions

o Programs can be only a few instructions or
millions of lines of instructions

40




PERFORMING A TASK ON THE COMPUTER

o Determine Output
o Identify Input

o Determine process necessary to turn given Input
into desired Output

41




PROBLEM-SOLVING: APPROACH LIKE
ALGEBRA CLASS

o How fast 1s a car traveling if it goes 50 miles in 2
hours?

o Output:
o Input:
o Process:

42




PROGRAM DEVELOPMENT CYCLE

Analyze: Define the problem.

Designe Plan the solution to the
problem.

Choose the interface: Select the objects
(text boxes, buttons, etc.).

Code: Translate the algorithm into a
programming language.

Test and debug: Locate and remove any
errors 1n the program.

Complete the documentation:
Organize all the materials that describe
the program.

43




PROGRAMMING TOOLS

o Three tools are used to convert algorithms into
computer programs:

 Flowchart - Graphically depicts the logical steps to
carry out a task and shows how the steps relate to each
other

 Pseudocode - Uses English-like phrases with some
Visual Basic terms to outline the program

 Hierarchy chart - Shows how the different parts of a
program relate to each other

44




FLOWCHART EXAMPLE

Read
sheets

input

Set stamps =
sheets /5

processing

v

Round stamps
up to next
whole number

processing

output

45




PSEUDOCODE EXAMPLE

o Determine the proper number of stamps
for a letter

o Read Sheets (input)
o Set the number of stamps to Sheets / 5

(processing)

o Round the number of stamps up to the
next whole number (processing)

o Display the number of stamps (ouitput)

46




HIERARCHY CHARTS EXAMPLE

Postage stamp

program
Read Calculate Display
sheets stamps stamps

Set stamps =
sheets /5

Round stamps
up to next whole
number

a7




DECISION FLOW CHART

Is

No condition Yes
If condition is true Then
Process step(s) 1 Process Process
Else
step(s) 2 step(s) 1
Process step(s) 2 P P
End If

48




LOOPING FLOW CHART

Is
condition
true?

Mo

Do While condition is true
Process step(s)

Loop

Process
step(s)

49
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CONTROL NAME PREFIXES

Control Prefix Example
button otn btnCompute
labe bl IblAddress
text box txt txtAddress
list box ISt IstOutput

Chapter 2 51




EVENT

o An event is an action, such as the user clicking on
a button

o Usually, nothing happens in a Visual Basic
program until the user does something and
generates an event.

o What happens is determined by statements.

52




THREE TYPES OF ERRORS

o Syntax error
o Run-time error

o Logic error

53




SOME TYPES OF SYNTAX ERRORS

o Misspellings
lstBox.Itms.Add (3)

o Omissions
lstBox.Items.Add (2 + )

o Incorrect punctuation
Dim m; n As Integer

Displayed as blue underline in VS

54




SYNTAX ERROR

The following 1s NOT a valid way to test if n falls
between 2 and 5:

2<n<5bH)

55




A TYPE OF RUN-TIME ERROR

Dim numVar As Integer = 1000000

numVar = numVar * numVar

What’s wrong with the above?

56




A LOGICAL ERROR

Dim average As Double
Dim m As Double = 5
Dim n As Double = 10
average = m + n / 2

What’s wrong with the above?
Value of average will be 10. Should be 7.5.

57




COMMON ERROR IN BOOLEAN EXPRESSIONS

o A common error 1s to replace the condition Not (
2 <3 ) with the condition (2> 3 )

58




DATA CONVERSION

o Because the contents of a text box 1s always a
string, sometimes you must convert the input or
output.

dblvar = (txtBox.Text)

t

Converts a String to a Double

txtBox.Text = (numVar)

4 s

Converts a number to a string




STRING PROPERTIES AND METHODS

"Visual".ToUpper 1s VISUAL.

.ToUpper makes everything upper case.

Varname = “blah”

Varname.ToUpper - “BLAH”

60




STRING PROPERTIES AND METHODS

"a" & " bed ".Trim & "efg" is “abcdefg”

trim removes leading/trailing spaces

Varname =“ blah *

Varname.trim - “blah”

61




SUBSTRING METHOD

Let str be a string.

str.Substring (m, n) is the substring of
length n, beginning at position m in str.

“Visual Basic”.Substring(2, 3) 1s “sua”
“Visual Basic”.Substring(0, 1) 1s “V”




CHR FUNCTION

For n between 0 and 255,

Chr (n)
1s the string consisting of the character with
ASCII value n.

EXAMPLES: Chr (65) is "A"
Chr (162) is "¢"




ASC FUNCTION

For a string str,
Asc(str)

1s ASCII value of the first character of str.

EXAMPLES: Asc ("A") 1is 65
Asc("¢25") 1s 162

64




SCOPE

o The scope of a variable is the portion of the
program that can refer to it

o Variables declared inside an event procedure are
sald to have local scope and are only available in
the event procedure in which they are declared

65




SCOPE

o Variables declared outside an event procedure are
sald to have class-level scope and are available
to every event procedure

o Usually declared after
formName

(Declarations section of Code Editor.)

66




® REVIEW

Chapter 4




LOGICAL OPERATORS

o Used with Boolean expressions

o — makes a False expression True and vice versa

° — will yield a True if and only if both expressions
are True

o — will yield a True if at least one of both

expressions are True

68




EXAMPLE 4.3

n=4,answ =“Y”

Are the following expressions true or false?

(n < 6)
(answ ="Y") Or (answ ="v")
(answ ="Y") (answ ="y")

Not(answ ="v")

69




The program will take a course of action
based on whether a condition 1s true.

condition
actionl

action?2

Will be executed if
condition is true

<
S

Will be executed if
condition is false

IF BLOCK

70




ANOTHER EXAMPLE IF BLOCK

condition
actionl

Regardless of whether
the condition in the

Statement?2 _
If statement is true or

S tatement3 alse, these statements
will be executed

71




PSEUDOCODE AND FLOWCHART

No I5 t.h? Yes
condition
If condition is true Then
Processing step(s) 1
Elsze Execute Execute
Processing step(s) 2 processing step(s) 2 processing step(s) 1
End If

72




ELSEIF CLAUSE

If conditionl Then
actionl

Elself condition2 Then
action2

Elself condition3 Then
action3

Else
action4

End If

73




SELECT CASE SYNTAX

The general form of the Select Case block 1s
Select Case selector

Case valueListl
actionl
Case valueList2
action2
Case Else
action of last resort
End Select

74




FLOWCHART FOR SELECT CASE

EEEEEEEE

ssssssss




FLOWCHART FOR SELECT CASE

o (not 1n book, but equivalent)

Instructions Instructions Instructions Instructions
for casze 1 for casze 2 for case 3 for caze n
Execution

continues

76
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DEVICES FOR MODULARITY

o Visual Basic has two devices for breaking
problems into smaller pieces:
e Sub procedures
e Function procedures

78




SUB PROCEDURES

o Perform one or more related tasks
o General syntax

Sub ProcedureName()
statements

End Sub

79




ARGUMENTS AND PARAMETERS

Sum(2, 3)

T T arguments

4 parameters ]
Sub Sum(ByVal numl As Double, ByVal num2 As Double)

displayed |

automatically

80




FUNCTION PROCEDURES

o Function procedures (aka user-defined functions)
always return one value

o Syntax:
Function FunctionName (ByVal wvarl As Typel,

ByVal var2 As TypeZ2,

..) As dataType
statement (s)
Return expression
End Function

81




FUNCTIONS VS. PROCEDURES

o Both can perform similar tasks
o Both can call other subs and functions

o Use a function when you want to return one and
only one value

82




EXAMPLE: NUM

Public Sub btnOne Click (...) Handles _
btnOne.Click
Dim num As Double = 4
Triple (num)
txtBox.Text = CStr (num)
End Sub

Sub Triple (ByVal num As Double)
num = 3 * num
End Sub

Output: 4

83




EXAMPLE

Public Sub btnOne Click (...) Handles _
btnOne.Click
Dim num As Double = 4
Triple (num)
txtBox.Text = CStr (num)
End Sub

Sub Triple (ByRef num As Double)
num = 3 * num
End Sub

Output: 12

84
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DO LOOP SYNTAX

Condition is tested,

If it is true,
the loop is run.
condition If it is false,
the statements
statement (s) following the

T Loop statement
are executed.

These statements are inside
the body of the loop and
are run if the condition
above is true.

86




POST TEST LOOP

statement (s)

condition

T

Loop is executed once and then the condition
Is tested. If it is false, the loop is run again.
If it is frue, the statements following the
Loop statement are executed.

87




WHAT’S THE DIFF?

What’s the
statement (s) difference
condition between a
Do Until
condition
and

statement (s)

Do While?

88



PSEUDOCODE AND FLOWCHART

Do
statement(s)
Loop Until condition is true

4

Is th:e No Execute
cntr:ﬂ:;on statements
within
the loop

Execute
statements
within
the loop No Is t_h?
condition
true?
Y
Execute Ececute
srt]ate;nﬁnts Do While condition is true ctatements
that tollow : .
the loop L Processing step(s) that follow 89
oop the loop




EXAMPLE 1: DISPLAY THE TOTAL
CONTENTS OF A FILE

Dim sr As IO.StreamReader =

I0.File.OpenText (" PHONE . TXT")
lstNumbers.Items.Clear ()
Do While sr.Peek <> -1
name = sr.ReadLine
phoneNum = sr.ReadLine
lstNumbers.Items.Add (name & " "
& phoneNum)

Loop
sr.Close () 90




FOR...NEXT LOOP SYNTAX

.

initial value — | Fori=mTon terminating value
control variable —  statement(s) < body

Next

91




EXAMPLE 2

For 1 As Integer = 0 To n Step s
lstValues.Items.Add (1)
Next

92




COMMENTS

o The value of the control variable should not be
altered within the body of the loop (For ... Next).

o To skip an iteration in a For .. Next loop:
Continue For

o To skip an iteration in a Do .. While loop:
Continue Do

93




For i As Integer = 1 To 5
(some statements)
Continue For
(some statements)
Next

What will happen?

COMMENTS

94




COMMENTS

o To break out of a For .. Next loop:
Exit For

o To break out of a Do .. While loop:
Exit Do

95
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SIMPLE AND ARRAY VARIABLES

o A variable (or simple variable) is a name to
which Visual Basic can assign a single value

o An array variable 1s a collection of simple
variables of the same type to which Visual Basic
can efficiently assign a list of values

97




INITIALIZING ARRAYS

o Arrays may be initialized when they are created:

arrayName () = {valueO, _
valuel, value2, ..., valueN}
o For Ex:

Dim Students() As String = {"Jack",
"John", "Julie", "Jimmy", "Janet"}

98




INITIALIZING ARRAYS

o Arrays may be initialized when they are
created:

arrayName () =
IO.File.ReadAllLines (filespec)

o Opens filespec, reads all lines from 1t, and
stores 1t 1n arrayName

o Each line 1n filespec 1s stored in one
location of arrayName

99




Grades ()

Grades
Grades
Grades
Grades

Grades

.Average -> 80
.Count =2 5
.Min 2 70
.Max =2 90
.Sum =2 400

EXAMPLE

100




PRESERVE KEYWORD

arrayName (m) resets all values to

their default. This can be prevented with the
keyword Preserve.

arrayName (m)

resizes the array and retains as many
values as possible.

101




SET OPERATIONS

o Concat
» Contains elements of arrayl and array?2
e Duplication 1s OK

Dim Statesl() As String = {"A", "B", "C", "D"}
Dim States2() As String = {"E H"}

Dim States3() As String = _
Statesl.Concat(States2).ToArray()

102




SET OPERATIONS

o Union
» Contains elements of arrayl and array?2
* No Duplication

Dim Statesl() As String = {"A", "B", "C", "D"}
Dim States2() As String = {"E H"}

Dim States3() As String = _
Statesl.Union(States2).ToArray()

103




SET OPERATIONS

o Intersect

» Contains elements from arrayl and array2 which
exist in both arrayl and array2

Dim Statesl1() As String = {"A", "B", "C", "D"}
Dim States2() As String = {"E H"}

Dim States3() As String = _
Statesl.Intersect(States2).ToArray()

104




SET OPERATIONS

o Except

» Contains elements from arrayl which do not exist in
array2

Dim Statesl1() As String = {"A", "B", "C", "D"}
Dim States2() As String = {"E H"}

Dim States3() As String = _
Statesl.Except(States2).ToArray()
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STRUCTURES

o A way of grouping heterogeneous data
together

o Also called a UDT (User Defined Type)

o Sample structure definition:
College

name
state
yearFounded
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Structure FullName
Dim firstName As String
Dim lastName As String
End Structure

Structure Student

Dim name As FullName

Dim credits () As Integer
End Structure

EXAMPLE 4

Structure "FullName"
contained, or nested,
inside Student
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SORTING

o Sorting 1s an algorithm for ordering an
array.

o We discuss two sorting algorithms:
* bubble sort
o Shell sort

o Both use the swap algorithm:
temp = varl
varl = var2

var?2 = temp
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BUBBLE SORT ALGORITHM: N ITEMS

Compare the first and second items. If they are
out of order, swap them.

Compare the second and third items. If they are
out of order, swap them.

Repeat this pattern for all remaining pairs. The
final comparison and possible swap are between
the next-to-last and last items.

The last item will be at its proper place.
Do another pass through first n — 1 items.

Repeat this process with one less item for each
pass until a pass uses only the first and second
1tems.
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SHELL SORT ALGORITHM

Begin with a gap of g = Int(n/2)
Compareitems Oand g, land 1 +g, .. .,

n - g and n. Swap any pairs that are out
of order.

Repeat Step 2 until no swaps are made
for gap g.
Halve the value of g.

Repeat Steps 2, 3, and 4 until the value
of g1s 0.

110




REVIEW

Efficiency of Bubble and Shell Sorts

Array Elements Bubble Sort Shell Sort
Comparisons Comparisons

5 10 17
10 45 57
15 105 115
20 190 192
25 300 302
30 435 364
50 1225 926
100 4950 2638
500 124,750 22,5617

1000 499,500 58,460




REVIEW

o Efficiency of Sequential and Binary Search

Array Elements Sequential Search Binary Search
Comparisons Comparisons

2000 1000 (Average) 11 (At most)
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REVIEW

name = input.Substring(0, (input.IndexOf(",")))

Input = “James,88”

n.
J a m e S , 8 8




WRITEALLLINES

oI0.File.WriteAllLines

("fileName.txt", States)

o Creates a new text file

o Copies the contents of a string array
o Places one element on each line

o Close the file
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REALALLLINES

o Read all the lines of a text-file into an
array
e« Method opens a file
e Reads each line of the file
e Adds each line as an element of a string array
e Closes the file

o A line 1s defined as a sequence of
characters followed
e carriage return
* a line feed
» a carriage return followed by a line feed
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DELETING INFORMATION FROM A
SEQUENTIAL FILE

o An 1individual item of a file cannot be
changed or deleted directly.

o A new file must be created by reading each
item from the original file and recording it,
with the single item changed or deleted,
into the new file.

o The old file 1s then erased, and the new file
renamed with the name of the original file.
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DELETE AND MOVE METHODS

o Delete method:
IO.File.Delete(filespec)

o Move method (to change the filespec of a file):

IO.File.Move (oldfilespec,
newfilespec)

o Note: The 10.File.Delete and 10.File.Move
methods cannot be used with open files.
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STRUCTURED EXCEPTION HANDLING

o Two types of problems in code:

» Bugs (logic error) — something wrong with the code
the programmer has written

o FExceptions — errors beyond the control of the
programmer

o Programmer can use the debugger to find bugs;
but must anticipate exceptions in order to be able
to keep the program from terminating abruptly.
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TRY CATCH BLOCK SYNTAX

normal code
excl FirstException
exception-handling code for FirstException
exc2 SecondException
exception-handling code for SecondException

exception-handling code for any remaining
exceptions

clean-up code
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CATCH BLOCKS

o Visual Basic allows Try-Catch-Finally
blocks to have one or more specialized
Catch clauses that only trap a specific type
of exception

o The general form of a specialized Catch
clause 1s

Catch exp As ExceptionName

o where the variable exp will be assigned
the name of the exception. The code 1n this
block will be executed only when the o1
specified exception occurs.




WORKING WITH HASHTABLE

o Arrays can store only one data type

o collections can hold any objects

o Accessing the element 1s very simple and
very fast

o Removing the element in Collection is very
simple
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WORKING WITH HASHTABLE

o Array:
» MyArray(100) returns element 100

o What if I want element “George”?

o Hashtable
 MyHash.Item(“George”)
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WORKING WITH HASHTABLE

o Adding an element to the HashTable

o {hash table object}.Add(Key as Object, value as
Object)

o Ex: MyHash.Add(“George”, 45)
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WORKING WITH HASHTABLE

o Accessing an element
thash table object}.Item({key})

Ex: MyArray.Item(“George”)
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WORKING WITH HASHTABLE

o Searching for an element

o {hash table object}.Contains({key})

Ex: MyArray.Contains(“George”)
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LIST BOX EVENTS

Three main types of events with list boxes:
1. Click — the user clicks on an item 1n the list box

2. SelectedIndexChanged - the user clicks on an
1tem or uses the arrow keys to select 1t

2. DoubleClick - the user double-clicks on an item

All three events are triggered when the user double-
clicks on an 1tem.
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USING AN ARRAY TO FILL A LIST BOX

The statement
lstBox.DataSource = arrayName

fills the list box with the elements of the
array.
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THE GROUP BOoX CONTROL

o Group boxes are passive objects used to group
other objects together

o When you drag a group box, the attached controls
follow as a unit

o To attach a control to a group box, create the
group box, then drag the control you want to
attach into the group box.
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THE CHECK BOoX CONTROL

o Consists of a small square and a caption
o Presents the user with a Yes/No choice

o During run time, clicking on the check box
toggles the appearance of a check mark

o Checked property 1s True when the check
box 1s checked and False when 1t 1s not

o CheckedChanged event 1s triggered when
the user clicks on the check box
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THE RADIO BUTTON CONTROL

o Consists of a small circle with a caption (that is
set by the Text property)

o Normally several radio buttons are attached to a
group box

o Gives the user a single choice from several options

o Clicking on one radio button removes the selection
from another
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THE TIMER CONTROL

o Invisible during run time
o Triggers an event after a specified period of time

o The Interval property specifies the time period —
measured in milliseconds

o To begin timing, set the Enabled property to True
o To stop timing, set the Enabled property to False

o The event triggered each time Timerl.Interval
elapses 1s called Timerl.Tick 133




SCROLL BAR PROPERTIES

o The main properties of a scroll bar control
are
e Minimum
e Maximum
e Value
 SmallChange,
e LargeChange

o hsbBar.Value, a number between
hsbBar.Minimum and hsbBar.Maximum,
o1ves the location of the scroll box,
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THE CLIPBOARD OBJECT

o Used to copy information from one place to
another

o Maintained by Windows, so 1t can even be used
with programs outside Visual Basic

o A portion of memory that has no properties or
events
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THE RANDOM CLASS

o A random number generator declared with the
statement:

randomNum Random ()

o If m and n are whole numbers and m <n then the
following generates a whole number between m
and n (including m, but excluding n)

randomNum.Next (m, n)
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THE MENUSTRIP CONTROL

Used to create menus like the following:

Top'level menUNW‘ Calor

fl

L

Y Demonstrate Menus

.:.El-ihl‘

scending  Ctrl+A

1= | 1=

escending  Ctrl+D

Second-level menu

137




MENU EVENTS

o Each menu item responds to the Click event

o Click event 1s triggered by
e the mouse

o Alt + access key
o Shortcut key
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MULTIPLE FORMS

o Visual Basic programs can contain more than one
form

o To add the new form, select Add Windows Form
from the Project menu, to invoke the Add New
Items dialog box.
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VARIABLES AND MULTIPLE FORMS

o Variables declared in the Declarations section of a
form with Public, instead of Dim, will be available
to all forms in the program

o When a Public variable 1s used in another form, it
1s referred to by an expression such as

secondForm. variableName
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WHAT IS A DATABASE?

oA database (DB) 1s a very large,
integrated, permanent collection of data

o Models real-world
« Entities (e.g., students, courses)

» Relationships (e.g., Madonna 1s taking
CMPT354)

o Example databases:
o Customer Transactions
e Human Genome
e Online Bookstore




DATABASE TERMINOLOGY

o A table 1s a rectangular array of data

o Each column of the table, called a field, contains
the same type of information

o Each row, called a record, contains all the
information about one entry in the database
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CONNECTING WITH A DATATABLE

Dim dt As New DataTable ()

Dim connStr As String = _
"Provider=Microsoft.Jet .OLEDB.4.0;" &
"Data Source=MEGACITIES.MDB"

Dim sqlStr As String = "SELECT * FROM Cities"

Dim dataAdapter As New _
OleDb.OleDbDataAdapter (sqlStr, connStr)

dataAdapter.Fill (dt)

dataAdapter.Dispose ()

144
(Boilerplate to be inserted into every program in chapter.)



PRIMARY KEYS

o A primary key is used to uniquely identify each
record

o Databases of student enrollments in a college
usually use a field of Social Security numbers as
the primary key

o Why wouldn't names be a good choice as a
primary key?
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TwWO OR MORE TABLES

o When a database contains two or more
tables, the tables are usually related

o For instance, the two tables Cities and
Countries are related by their country field

o Notice that every entry 1n Cities.country
appears uniquely in Countries.country and
Countries.country 1s a primary key

o We say that Cities.country is a foreign
key of Countries.country 146




SQL

o Structured Query Language developed for use
with relational databases

o Very powerful language

o Allows for the request of specified information
from a database

o Allows displaying of information from database in
a specific format
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VIRTUAL TABLES

o SQL statements create a new “virtual”
table from existing tables

SELECT city, pop2015 FROM Cities
WHERE pop2015>=20

Results 1n “virtual” table

city pop2015
Bombay 22.6
Delhi 20.9

Mexico City  20.6
Sao Paulo 20.0
Tokyo 36.2 148
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WHAT IS OBJECT ORIENTED
PROGRAMMING?

An object 1s like a black box.
The internal details are hidden.

- Identifying objects and assigning responsibilities to
these objects.

- Objects communicate to other objects by sending
messages.

- Messages are received by the methods of an object 150




OOP ANALOGY

Classes noun A word used to denote or
name a person, place, thing,
guality, or act.

Methods verb That part of speech that
expresses existence, action, or
occurrence.
Properties adjective Any of a class of

words used to modify a noun or
other substantive by limiting,

gualifying, or specifying.
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(GET AND SET

Private m name As String

Public Property Name () As String
Get
Return m name
End Get
Set(ByVal value As String)
m name = value
End Set
End Property
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STUDENT CLASS: WRITEONLY
PROPERTY BLOCKS

Public WriteOnly Property Midterm() As Double
Set(ByVal value As String)
m midterm = value
End Set
End Property

Public WriteOnly Property Final () As Double
Set(ByVal value As String)
m final = value
End Set
End Property
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STUDENT CLASS: METHOD

Function CalcSemGrade() As String
Dim grade As Double
grade = (m midterm + m final) / 2
grade = Math.Round (grade)
Select Case grade
Case Is >= 90

Return "A"
Case Is >= 80
Return "B"

End Function
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STEPS USED TO CREATE A CLASS

Identify a thing in your program that is to
become an object

Determine the properties and methods that you
would like the object to have. (As a rule of
thumb, properties should access data, and
methods should perform operations.)

A class will serve as a template for the object.
The code for the class 1s placed in a class block
of the form

ClassName
statements
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STEPS CONTINUED

For each of the properties in Step 2, declare a
private member variable with a statement of the
form

m variableName DataType

For each of the member variables in Step 4,
create a Property block with Get and/or Set
procedures to retrieve and assign values of the
variable.

For each method in Step 2, create a Sub
procedure or Function procedure to carry out

the task. 156




EVENTS

o User-defined events can be created for classes.

o The statement for triggering an event is located in
the class block

o The event 1s dealt with in the form’s code.
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USER DEFINED EVENT

o Suppose that the event 1s named UserDefinedEvent and
has the parameters parl, par2, and so on.

o In the class block, place the following statement in the
Declarations section

UserDefinedEvent ( parl
DataTypel, par2 DataType2, ...)

o The next statement should be placed at the locations in
the class block code at which the event should be
triggered

UserDefinedEvent (argl, arg2,




RESPONDING TO EVENTS

o When declaring an object variable, the keyword
WithEvents must be added so that the object will respond
to events:

objectl ClassName

o The declaration line of an event procedure would be

objectl UserDefinedEvent ( parl As

;e ) objectl.UserDefinedEvent
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CONTAINMENT

o Class A contains class B when a member
variable of class A 1s an object of type class B.

Class DeckOfCards
Private m deck(51l) As Card

'Class DeckOfCards contains class
Card
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INHERITANCE HIERARCHY

o GrandChild1 has access to Property A, Sub B, and
Event C from its parent and adds Function E and
Sub F

Parent

Property A
Sub B

[ ]
Child1 Child2 Child3
Event C Property D
I
I |
GrandChild1 GrandChild2
Function E Event G

Sub F 161




OVERRIDABLE

o The keyword Overridable 1s used to
designate the parent’s methods that are
overridden, and the keyword Overrides
1s used to designate the child’s methods
that are doing the overriding

o There are situations where a child class's
needs to access the parent class’s
1implementation of a method that the child
1s overriding. Visual Basic provides the
keyword MyBase to support this

functionality
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MUSTOVERRIDE

o Sometimes you want to insist that each child of a
class have a certain property or method that it
must implement for 1ts own use

o Such a property or method is said to be abstract
and 1s declared with the keyword MustOverride
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o Good luck!




